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1 ПОКАЗАТЕЛИ ОЦЕНИВАНИЯ ПЛАНИРУЕМЫХ РЕЗУЛЬТАТОВ ОБУЧЕНИЯ 

Результаты 
Основные показатели 

оценки результата 

Формы и методы 

контроля и оценки 

У1. Определять порядок и 

этапы конструкторской 

документации 

 умение определять порядок и 

этапы конструкторской 

документации 

Устный опрос 

У2. Конструировать сборочные 

единицы электронных приборов 

и устройств 

 умение конструировать 

сборочные единицы электронных 

приборов и устройств 

Практическая работа, 

курсовой проект 

У3. Применять программное 

обеспечение для проведения 

технического обслуживания и 

эксплуатации различных видов 

электронных приборов и 

устройств 

 умение применять программное 

обеспечение для проведения 

технического обслуживания и 

эксплуатации различных видов 

электронных приборов и 

устройств 

Практическая работа 

У4. Разрабатывать проектно-

конструкторскую и 

технологическую 

документацию электронных 

приборов и устройств 

 умение разрабатывать проектно-

конструкторскую и 

технологическую документацию 

электронных приборов и 

устройств 

Практическая работа, 

курсовой проект 

У5. Составлять электрические 

схемы и расчеты параметров 

электронных приборов и 

устройств 

 умение составлять электрические 

схемы и расчеты параметров 

электронных приборов и 

устройств 

Практическая работа, 

курсовой проект 

У6  Проектировать электронные 

приборы и устройства с 

использованием прикладных 

программ сквозного 

автоматизированного 

проектирования 

  проектировать электронные 

приборы и устройства с 

использованием прикладных 

программ сквозного 

автоматизированного 

проектирования 

Практическая работа, 

курсовой проект 

З1. требования ЕСКД и ЕСТД  знание требований ЕСКД и 

ЕСТД 

Устный опрос, 

практическая работа 

З2. этапы разработки и 

жизненного цикла электронных 

приборов и устройств 

 знание этапов разработки и 

жизненного цикла электронных 

приборов и устройств 

Тестирование на 

платформе Ipsilon Uni 

З3. порядок и этапы разработки 

конструкторской документации 
 знание порядка и этапов 

разработки конструкторской 

документации 

Тестирование на 

платформе Ipsilon Uni 

З4 типовые пакеты прикладных 

программ, применяемые при 

конструировании электронных 

приборов и устройств 

 знание типовых пакетов 

прикладных программ, 

применяемые при 

конструировании электронных 

приборов и устройств 

Тестирование на 

платформе Ipsilon Uni, 

практическая работа, 

курсовой проект 

З5 типовой технологический 

процесс и его составляющие; 

основы проектирования 

технологического процесса 

  знание типового 

технологического процесса и его 

составляющих; основ 

проектирования 

технологического процесса 

Устный опрос 

З6 технологические процессы 

производства печатных плат, 

интегральных микросхем и 

микросборок 

 знание технологических 

процессов производства 

печатных плат, интегральных 

микросхем и микросборок 

Устный опрос, 

практическая работа, 

курсовой проект 
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2 ОЦЕНОЧНЫЕ СРЕДСТВА 

 

2.1 Задания для текущего контроля 

2.1.1 Устный опрос 

Цель устного опроса – оценить знания и кругозор обучающегося по дисциплине, умение 

логически строить ответ, грамотность речи, уровень развития пространственного 

мышления. Обучающая функция устного опроса состоит в выявлении вопросов, которые 

по каким-то причинам оказались недостаточно осмысленными в ходе учебных занятий и 

определении способов коррекции «пробелов» в знаниях и умениях обучающихся. 

Опрос проводится фронтально или индивидуально с целью проверки отдельных знаний 

обучающихся. При устном опросе студенты дают развернутые ответы на поставленные 

вопросы. 

1. Перечислите основные библиотеки Altium Designer. 

2. Алгоритм создания и настройки проекта.  

3. Как создать библиотеку PCB Library?  

4. Как создать библиотеку Schematic Library?  

5. Как создать библиотеку Int Library? 

6. Алгоритм передачи данных между схемой и PCB при создании простых проектов.  

7. Назовите требования к иерархическому проекту и способы подготовки к его 

созданию.  

8. Назовите типовые иерархические схемы и связи иерархических проектов. 

9. Алгоритм создания классов цепей.  

10. Алгоритм создания правил для цепей и классов. 

11. Как осуществляется поиск компонентов на схеме?  

12. Создание библиотеки компонентов.  

13. Как настраиваются параметры при создании новой схемы?  

14. Перечислите правила создание классов для печатной платы. 

15. Алгоритм внесения изменений в схему и передача изменений на PCB. 

16. Назовите правила подготовки и размещения текстовой и пояснительной 

информации на печатной плате. 

17. Правила формирования 3D изображения печатной платы и PDF файла проекта. 

18. Алгоритм создания шаблона и контура печатной платы. 

19. Алгоритм создания модуля Database Library из существующих библиотек.  

20. Назовите правила создания базы данных для ее использования в качестве Database 

Library.  

21. Перечислите общие требования к типовому проекту. 

22. Как задаются общие правил проекта? 

23. Алгоритм автоматической генерации классов. 

24. Назовите основные правила при создании модуля Electrical Clearance.  

25. Назовите основные правила при создании модуля Routing Widht.  

26. Назовите основные правила при создании модуля Routing/Routing Topology.  

27. Назовите основные правила при создании модуля Routing/Routing Layer.  

28. Назовите основные правила при создании модуля Routing/Routing Corners.  

29. Назовите основные правила при создании модуля Routing/Routing Vias Style.  

30. Назовите основные правила при создании модуля Routing/Differential Pours Routing. 

31. Назовите основные правила при создании модуля SMT.  
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32. Назовите основные правила при создании модуля Mask.  

33. Назовите основные правила при создании модуля Plane. 

34. Как задаются правила топологии в PCB редакторе?  

35. Назовите основные правила при создании модуля Testpoint и Manufacturing.  

36. Назовите основные правила при создании модуля High Speed.  

37. Назовите основные правила при создании модуля Placement.  

38. Алгоритм расстановки компонентов.  

39. Назовите основные правила при создании модуля Room из компонентов.  

40. Назовите основные правила при создании модуля Union. 

41. Как создать Database Library из существующих библиотек?  

42. Правила настройки библиотеки Database Library. 

 

 

2.1.2 Практические работы 

Практическая работа № 17 «Настройка параметров конфигурации и среды 

проектирования» 

Цель работы: Освоение навыков настройки параметров конфигурации и среды 

проектирования. 

Ход работы: 

Задание 1 Создание проекта платы 

Задание 2 Настройка параметров проекта 

Все документы, библиотеки, настройки и т.д, относящиеся к одной плате, объединяются в 

проект Altium Designer. Именно с создания проекта начинается работа над новой платой. 

 

Задание 1 Создание проекта платы 

1. Выберите команду File » New » Project из главного меню. 

2. В открывшемся диалоговом окне Create Project задайте следующие настройки: 

 В списке Locations выберите Local Projects. 

 В списке Project Type выберите шаблон Base Dimmer Board Template. 

 В поле Project Name задайте имя проекта Base Dimmer Board. 

 В поле Folder нажмите кнопку , в открывшемся диалоговом окне Browse for 

project location перейдите в папку 

C:\Users\Public\Documents\Altium\AD_GOST_QS\QuickStart и нажмите кнопку 

Select Folder. 

file:///C:/Users/shami/Documents/Ð�Ð¾Ð»Ð»ÐµÐ´Ð¶%20Ð¸Ð¼.%20Ð¯Ð±Ð»Ð¾Ñ�ÐºÐ¾Ð²Ð°/Ð£Ñ�Ð¾ÐºÐ¸%20Ð¿Ð¾%20Altium/qs_sources/lesson_2.html%23create_pcb_project
file:///C:/Users/shami/Documents/Ð�Ð¾Ð»Ð»ÐµÐ´Ð¶%20Ð¸Ð¼.%20Ð¯Ð±Ð»Ð¾Ñ�ÐºÐ¾Ð²Ð°/Ð£Ñ�Ð¾ÐºÐ¸%20Ð¿Ð¾%20Altium/qs_sources/lesson_2.html%23project_parameters
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3. Нажмите кнопку Create. Диалоговое окно Create Project будет закрыто, и состав 

нового проекта будет отображен в панели Projects в левой части окна приложения. 

 
Подробнее об Управлении проектами в Altium Designer 

 

Задание 2 Настройка параметров проекта 

1. Щелкните ПКМ по названию проекта в панели Projects и выберите команду Project 

Options. 

2. В открывшемся диалоговом окне Project Options перейдите на вкладку Options и 

отключите опцию Automatic Sheet Numbering. 

 

https://www.altium.com/ru/documentation/altium-designer/project-management-in-altium-designer
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3. Нажмите кнопку OK, чтобы применить изменение и закрыть диалоговое окно. 

4. Дважды щелкните ЛКМ по строке файла Base Dimmer Board.SchDoc в панели 

Projects, чтобы открыть документ схемы. 

5. Выберите команду Reports » GOST BOM » Project Properties из главного меню. 

6. Задайте значения полей в открывшемся диалоговом окне Свойства 

проекта согласно изображению ниже. 

 
7. Нажмите кнопку OK. 

8. Сохраните изменения проекта – щелкните ПКМ по строке проекта в панели 

Projects и выберите команду Save. 

Для навигации по схеме используйте следующие сочетания клавиш: 

 Вращение колеса мыши с зажатой клавишей Ctrl – масштабирование. 

 Перемещение мыши с зажатой ПКМ – панорамирование. 

 Ctrl+PgDn – отображение всего документа схемы. 

 

Практическая работа № 18 «Изучение команд графического редактора» 

Цель работы: Изучение команд графического редактора при рисовании схемных символов 

компонентов. 

Ход работы: 

Задание 1 Подготовка рабочей области. 

Задание 2 Создание схемного символа 

Задание 3 Редактирование схемного символа 

Задание 4 Добавление и удаление вершин из полилиний 

Задание 5 Добавление выводов в символ 

Задание 6 Настройка свойств выводов 

Задание 7Использование панели SCH Library для создания схемных символов 

Задание 8 Определение свойств символа 

 

Задание 1 Подготовка рабочей области. Создание схемного символа 

Схемный символ, как правило, включает в себя фигуру, которая отражает назначение 

компонента, и один или множество выводов. Каким образом представлен компонент, т.е. 

его вид и расположение выводов, определяет проектировщик. Это необходимо делать в 

соответствии с требованиями вашего предприятия и принятыми вами стандартами. Один 

символ компонента может представлять целое физическое устройство, либо компонент 

можно определить множеством секций, каждая из которых представляет логическую 

ячейку физического компонента (например, ячейка И в компоненте 4И или катушка и 

наборы контактов реле). Компоненты этого типа также называется многосекционными. 

Создание схемного символа осуществляется путем размещения графических объектов, 

которые представляют тело компонента, и выводов, которые представляют физические 

контакты компонента. Схемные символы создаются в библиотеке схемных символов 
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(Schematic Library) редактора библиотек схемных символов Altium с расширением файлов 

*.SchLib. В библиотеке схемных символов можно создать любое количество символов 

компонентов. Организация символов в библиотеки должна соответствовать как 

требованиям предприятия, так и типу библиотеки компонентов, в которой должны 

находиться символы. 

Независимо от способа хранения определений моделей и компонентов, после размещения 

компонента на схеме он становится унифицированным компонентом. Символ появится на 

схеме; при его редактировании отображается полный набор параметров компонента, в том 

числе ссылки на модели и список параметров компонента. 

Физический компонент, который монтируется на плату, представляется множеством 

способов. На схеме компонент представляется логическим символом. В процессе 

симуляции SPICE используется SPICE-модель; в конструкции платы компонент 

представляется своим посадочным местом. Каждое из этих представлений называется 

доменной моделью, и каждый унифицированный компонент является совокупностью 

своих доменных моделей. 

Схемный символ является одной из доменных моделей, которая вместе с другими 

доменными моделями определяет унифицированный компонент. По сути, схемный 

символ имеет двойственную природу: он может выступать в роли простой доменной 

модели, созданной в редакторе библиотек, когда в нем нет ничего, кроме графики и 

набора выводов, и его также можно использовать как унифицированный компонент с 

прочими доменными моделями, такими как посадочное место, на которое задана ссылка в 

редакторе библиотек. Режим, который вы используете, будет зависеть от способа 

хранения и организации компонентов. Существует ряд способов хранения и организации 

компонентов, в том числе: 

 Простые библиотеки схемных символов и посадочных мест 

 Интегрированные библиотеки 

 Библиотеки на основе баз данных 

 Управляемые сервером компоненты 

 Подготовка рабочей области 

Настройка размера листа осуществляется на вкладке General в разделе Page Options 

панели Properties в режиме Document Options. Перед размещением объектов следует 

приближать вид, чтобы была видна сетка. 
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Используйте раздел Page Options панели Properties в режиме Document Options для 

задания размера листа. 

Всегда чертите символ компонента рядом к началом координат листа (центр листа). 

Системой единиц измерения по умолчанию для сетки документа схемы и схемной 

библиотеки является британская. Хотя все компоненты Altium созданы в дюймовой сетке, 

может быть полезным перейти на метрическую сетку, поскольку может быть сложно 

корректно соединить компоненты, созданные в различных сетках. Обратите внимание, что 

дюймовые сетки можно использовать с метрическими размерами листов, такими как A3, 

поэтому нет необходимости переключаться в метрическую сетку при работе с такими 

листами. Единицы измерения текущего листа определяются на вкладке General в разделе 

General панели Properties в режиме Document Options. 

 

 
 

Используйте раздел General панели Properties в режиме Document Options, чтобы задать 

единицы измерения для текущего листа. 

Размещение объектов осуществляется в текущей сетке привязки. Текущая сетка 

отображается внизу рабочей области в левой части строки состояния. 

 
Нажмите клавишу G для циклического переключения между доступными настройками 

сетки привязки. Эти настройки задаются на странице Schematic – Grids диалогового окна 

Preferences. 
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Используйте страницу Schematic – Grids диалогового окна Preferences для определения 

настроек сетки привязки. 

Как правило, объекты и выводы размещаются в сетке 5 мм или 2,5 мм, в то время как 

строковые объекты можно размещать в более мелкой сетке. 

 

Задантие 2 Создание схемного символа 

После задания настроек рабочей области необходимым образом следующим шагом 

является формирование графического представления компонента, т.е. создание графики 

компонента, которая будет представлять компонент при его размещении на листе схемы. 

Важно решить, по каким стандартам следует создавать компонент. Это обеспечит 

единообразие графики символов и согласованность результата. Методология 

проектирования Altium следует стандарту IEEE 315, который не только охватывает 

большинство элементов, но и четко определяет, как можно комбинировать 

полупроводниковые элементы для обозначения любых устройств. 

Создание тела символа осуществляется размещением графических объектов в рабочей 

области редактора схемных символов с помощью меню Place, панели инструментов 

Utilities или панели Active Bar. Дважды щелкните мышью по размещенному схемному 

объекту, чтобы открыть панель Properties для дальнейшей настройки объекта. 

Altium Designer включает в себя ряд замкнутых фигур, в том числе прямоугольник 

(Rectangle), полигон (Polygon), эллипс (Ellipse) и прямоугольник со скругленными углами 

(Round Rectangle), как показано ниже. 
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Линейные фигуры включают в себя дугу (Arc), линию/полилинию (Line   /Polyline), линию 

Безье (Bezier) и эллиптическую дугу (Elliptical Arc). Линии/полилинии могут включать в 

себя законцовки. Дважды щелкните мышью, чтобы открыть панель Properties для 

определения этих законцовок. 

 
 

Настройки свойств всех объектов по умолчанию, такие как ширина и цвет линий, 

определяются на странице Schematic – Defaults диалогового окна Preferences. 

 
Используйте страницу Schematic - Defaults диалогового окна Preferences для определения 

свойств схемных объектов по умолчанию. 

Свойства объектов также можно редактировать в процессе размещения. Нажмите клавишу 

Tab для редактирования свойств, когда объект прикреплен к курсору, до размещения 

объекта. Обратите внимание, что изменения, внесенные в процессе размещения, 

становятся новыми свойствами по умолчанию, если на странице Schematic - Defaults 

диалогового окна Preferences не включен параметр Permanent. 

 

Задание 3 Редактирование схемного символа 

Редактирование схемного символа 

Для перемещения объекта после его размещения зажмите ЛКМ на объекте и перемещайте 

мышь для размещения объекта в новое место. 

Чтобы изменить размер объекта после его размещения щелкните мышью по объекту, 

чтобы выделить его и отобразить ручки управления, затем зажмите мышь на одной из 

этих ручек управления, чтобы изменить размер объекта. 
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Задание 4 Добавление и удаление вершин из полилиний 

Вершины (ручки управления) можно добавлять и удалять из полилиний. Выделите 

полилинию, зажмите ЛКМ на линии или вершине и нажмите Insert или Delete, чтобы 

добавить или удалить вершину. 

 

Задание 5 Добавление выводов в символ 

Именно выводы компонентов определяют его электрические свойства и точки 

подключения входных и выходных сигналов. Вывод размещается для представления 

контакта физического компонента. 

Вывод можно разместить в рабочей области документа схемной библиотеки одним из 

следующих способов. В каждом случае, вывод прикрепляется к курсору электрическим 

концом. Поверните и/или отразите вывод, если необходимо, и щелкните мышью для 

размещения. 

Используйте команду Place » Pin (или последовательность P, P). 

Нажмите кнопку  в выпадающем меню объектов панели инструментов Utilities. 

Нажмите кнопку  на панели Active Bar. 

Когда панель Properties находится в режиме Component (дважды щелкните по компоненту 

в рабочей области), нажмите кнопку . Используйте выделенную кнопку на вкладке 

Pins панели Properties, чтобы открыть диалоговое окно Component Pin Editor. на вкладке 

Pins, чтобы открыть диалоговое окно Component Pin Editor, в котором вы можете 

добавлять (или редактировать) выводы. 

 
Используйте выделенную кнопку на вкладке Pins панели Properties, чтобы открыть 

диалоговое окно Component Pin Editor. 
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Используйте выделенную кнопку на вкладке Pins панели Properties, чтобы открыть 

диалоговое окно Component Pin Editor. 

 

Задание 6 Настройка свойств выводов 

Нажмите Tab, чтобы открыть панель Properties в режиме Component для редактирования 

свойств вывода перед его размещением. Числовые значения будут увеличиваться при 

размещении последующих выводов. Это автоматическое увеличение настраивается в 

области Auto-Increment During Placement на странице Schematic – General диалогового 

окна Preferences. Используйте отрицательные значения для автоматического уменьшения.  

 
Используйте страницу Schematic - General диалогового окна Preferences для определения 

автоматического увеличения значений. 

В процессе размещения или перемещения вывода он привязывается к курсору 

электрическим концом (также называется электрической точкой вывода). Вывод следует 

размещать таким образом, чтобы его электрическая точка была обращена от тела 

компонента. Нажимайте Пробел для поворота вывода в процессе его перемещения. 
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Выводы также можно размещать для представления электромеханических точек 

компонента, таких как вставка регулятора напряжения. 

У вывода есть набор свойств, в том числе название (Name) и обозначение (Designator). 

Именно обозначение используется для отображения вывода в контактную площадку 

посадочного места. Расстояние, на котором свойства Designator и Name отображаются от 

конца вывода, является настройкой редактора схем и схемных символов на системном 

уровне. Задайте Pin Margin на странице Schematic – General диалогового окна Preferences. 

 
Отдельные настройки для свойства Name можно задать в диалоговом окне Component Pin 

Editor. 

У вывода есть электрический тип (Electrical Type), который используется системой 

проверки электрических правил Altium для проверки корректности соединений выводов. 

Задайте этот параметр в диалоговом окне Component Pin Editor в соответствии с 

электрическим типом этого вывода компонента. Длина вывода Pin Length должна 

соответствовать выбранной сетке привязки. 

Для представления электрической информации вывода можно добавлять символы 

(Symbols) с помощью диалогового окна Component Pin Editor. 

 

Задание 7 Использование панели SCH Library для создания схемных символов 

Создание компонентов осуществляется с помощью объектов в редакторе библиотек 

схемных символов. Компоненты можно копировать и вставлять из одной библиотеки в 

другую или из редактора схем в редактор схемных символов. 

Общим подходом к созданию символа является копирование компонента из 

существующей библиотеки. Для этого необходимо: 

Открыть исходную библиотеку схемных символов и панель SCH Library (нажмите кнопку 

Panels в нижней правой части окна приложения и выберите SCH Library из выпадающего 

меню). 

Выберите нужный компонент (или компоненты). Используйте стандартные методики 

Windows для выделения множества компонентов. 

Щелкните ПКМ по выделенному компоненту и выберите команду Copy из контекстного 

меню. 

Откройте целевую схемную библиотеку, щелкните ПКМ где-либо в списке компонентов в 

панели SCH Library и выберите команду Paste из контекстного меню. 

Для создания новой библиотеки схемных символов: 
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Выберите команду File » New » Library » Schematic Library. Будет открыт пустой документ 

под названием Schlib1.SchLib, который отображает пустой компонент под названием 

Component_1. 

Нажмите File » Save As и переименуйте и сохраните новый документ схемной библиотеки 

в подходящее расположение с соответствующим именем. 

Используйте панель SCH Library для просмотра и управления символами компонентов 

открытой схемной библиотеки. Если панель не отображается, нажмите кнопку Panels в 

правой нижней части окна приложения и выберите SCH Library, чтобы открыть ее. 

 

Задание 8 Определение свойств символа 

Свойства символов, такие как позиционное обозначение и описание, редактируются в 

панели Properties в режиме Component (дважды щелкните по названию компонента в 

панели SCH Library).  

 
Режим Component панели Properties 

Если символ компонента был создан как доменная модель, необходимо задать только 

следующие настройки: 

Design Item ID – если символ является общим, например, это символ резистора, 

конденсатора или транзистора, этот параметр можно оставить пустым. Если это 

специальный символ определенного компонента, отредактируйте параметр, чтобы он 

отображал строку комментария на схеме необходимым образом. Имейте в виду, что этот 

параметр также передается на плату. 

Designator – введите нужный префикс позиционного обозначения со знаком вопроса ?. 

Description – эта строка полезна при поиске компонента. 

Если символ компонента не является чисто доменной моделью, необходимо добавить 

дополнительные параметры. Для общих символов параметр Design Item ID можно 

использовать для добавления определенного значения (в зависимости от рабочего 

процесса или концепции библиотеки). Также в раздел Parameters можно добавить 

дополнительную информацию. 
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Параметр Type определяет тип компонента, который представляет символ. 

Нестандартный компонент, такой как логотип компании (Graphical) или радиатор 

(Mechanical), можно создать как схемный символ и разместить в проекте. 

 
Задача создания схемных символов и определение свойств его выводов становится все 

более сложной, поскольку возрастает сложность компонентов. Например, для создания 

корректных символов больших компонентов в корпусах BGA, требующих размещения и 

настройки сотен выводов, могут понадобиться значительное время и ресурсы. 

Средство создания схемных символов Schematic Symbol Generation Tool 
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Для упрощения задачи создания схемных символов Altium предлагает эффективное 

средство создания схемных символов Schematic Symbol Generation Tool, основанный на 

интерфейсе мастера символов и диалогового окна редактора выводов. Средство обладает 

возможностью автоматического формирования графики символа, таблицами выводов и 

возможностями умной вставки данных. 

Средство Schematic symbol generation tool поставляется как дополнительный программный 

модуль, и он устанавливается в систему автоматически. Модуль отображается на вкладке 

Installed страницы Extensions & Updates. 

 
Чтобы создать новый символ компонента с помощью средства Schematic symbol generation 

tool, добавьте новый библиотечный компонент с помощью кнопки Add в панели SCH 

Library. Будет открыто диалоговое окно New Component, в котором вы можете ввести 

подходящее имя. Новый символ можно затем задать с помощью диалогового окна Symbol 

Wizard (Tools » Symbol Wizard). 

 
Диалоговое окно Symbol Wizard 

Настройки диалогового окна определяют базовую конфигурацию символа, в том числе его 

стиль (Layout Style) и количество выводов (Number of Pins). 

Параметр Layout Style позволяет выбрать один из предопределенных шаблонов с 

автоматически заданным расположением выводов. Используйте выпадающее меню для 

выбора предварительно заданных расположений. 

 

Практическая работа № 19 «Создание условного графического обозначения 

резистора и конденсатора» 

Цель работы: Освоение навыков создания условного графического обозначения резистора 

и конденсатора. 
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Ход работы: 

Задание 1 Создание схемного символа 

Из панели Projects откройте документ библиотеки схемных символов двойным щелчком 

ЛКМ по строке документа Dimmer.SchLib (находится в категории Libraries/Schematic 

Library Documents). 

Для навигации по документу библиотеки схемных символов используйте те же сочетания 

клавиш, что и для документа схемы. 

Выберите команду Tools » New Component из главного меню. 

В открывшемся диалоговом окне New Component укажите Design Item ID компонента 

VJ1825Y105KXXAT и нажмите кнопку OK. 

В рабочей области редактора выделите параметры Designator и Comment, обозначенные 

звездочками, и в панели Properties задайте для них шрифт Altium GOST Type A, размер 20, 

курсивное начертание. 

Выберите команду Place » Pin из главного меню. 

Нажмите клавишу Tab, чтобы перейти в режим редактирования свойств размещаемого 

объекта. 

В открывшейся панели Properties задайте следующие свойства размещаемого вывода: 

 в полях Designator и Name задайте значение 1; 

 отключите видимость Designator и Name, нажав иконки  справа от полей 

(иконки примут вид ); 

 укажите значение длины вывода Pin Length = 2.5mm; 

 в разделе Symbols для свойства Line Width укажите значение Small. 

Вводить единицы измерения (mm) не обязательно – система автоматически добавит 

единицы измерения документа. 

 



18 

Нажмите кнопку  в центре рабочей области, чтобы вернуться к размещению объекта. 

Нажмите два раза клавишу Пробел, чтобы повернуть вывод на 180 градусов. 

Наведите курсор мыши так, чтобы электрическая точка вывода, обозначенная небольшим 

косым перекрестием, оказалась в начале координат схемного символа, и щелкните ЛКМ, 

чтобы разместить вывод. 

К курсору будет привязан следующий вывод для размещения – нажмите два раза клавишу 

Пробел, чтобы повернуть вывод на 180 градусов. 

Разместите второй вывод правее первого. 

 

 
 

Щелкните ПКМ или нажмите клавишу Esc, чтобы выйти из режима размещения. 

Выберите команду Place » Line из главного меню. 

В свойствах линии задайте синий цвет. 

Разместите одну из линий, показанных на изображении ниже: 

щелкните ЛКМ в точке начала линии; 

переместите курсор в точку конца линии; 

щелкните ПКМ, чтобы завершить ввод текущей линии. 

Режим размещения линии останется активным. Аналогичным образом, разместите 

оставшиеся три линии, чтобы сформировать графику компонента согласно изображению 

ниже. 

После ввода последней линии щелкните ПКМ или нажмите клавишу Esc, чтобы выйти из 

режима размещения. 

 
 

Снимите выделение с объектов, щелкнув ЛКМ в свободном месте рабочей области. 

В панели Properties в режиме Component укажите следующие значения свойств: 

Designator = C? 

Comment = 1825 1 uF 25 V ±10 % X7R 

Description = Керамический чип-конденсатор 

Отключите видимость параметра Comment. 

В разделе Parameters нажмите кнопку Add и выберите Parameter из открывшегося меню. 

Задайте добавленному параметру название Value и значение 1uF. Когда параметр 

выделен, с помощью элемента управления в нижней части раздела задайте шрифт Altium 

GOST Type A, размер 20, курсивное начертание. 

Нажмите слева от названия параметра, чтобы включить его видимость в рабочей области. 
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Щелкните ПКМ по строке документа библиотеки в панели Projects и выберите команду 

Save, чтобы сохранить библиотеку. 

 

2.1.3 Тестовые задания 

Тестовые задания применяются для объективной оценки знаний и навыков обучающихся, 

в заданиях приводятся варианты вопросов требующие владения терминологией, наличие 

практических навыков по работе с программой Altium Designer и технической 

документацией.  

Обучающийся должен обладать следующими знаниями:  

 знание этапов разработки и жизненного цикла электронных приборов и устройств; 

 знание порядка и этапов разработки конструкторской документации; 

 знание типовых пакетов прикладных программ, применяемые при 

конструировании электронных приборов и устройств 

 

1. Команда размещения компонентов на схеме 

А. Add Existing to Project В. Place 

Б. Project Properties Г. Design Item ID 

 

2. Название параметра библиотечных идентификаторов компонентов 

А. Project Properties В. Design Item ID  

Б. Place  Г. Add Existing to Project 

 

3. Режим размещения линий групповых однородных связей 

А. Project Properties  В. Bus 

Б. Add Existing to Project Г. Place 

 

4. Команда размещения идентификаторов цепей 

А. Bus В. Power Port 

Б. Project Properties Г. Design Item ID 
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5. Команда использования проектных директив 

А. Parameter Set В. Place 

Б. Design Item ID Г. Add Existing to Project 

 

6. Команда настройки правил для ширины трасс цепей 

А. Design В. Add Existing to Project 

Б. Project Properties Г. Power Port 

 

7. Команда размещения компонентов на плате 

А. Add Existing to Project В. Parameter Set 

Б. Place From File Г. Design Item ID 

 

8. Команда интерактивной трассировки 

А. Parameter Set В. Interactive Routing 

Б. Design Item ID Г. Place 

 

9. Команда проверки правил проектирования 

А. Add Existing to Project В. Place 

Б. Project Properties Г. Run DRC Rule Class 

 

10. Какое правило не задает способ подключения PAD к полигону 

А. Direct Connect В. No Connect 

Б. Project Properties Г. Relief Connect 

 

11. Какое правило не задает способ подключения PAD к полигону 

А. Direct Connect В. No Connect 

Б. Project Properties Г. Relief Connect 

 

12. Минимальное рекомендованное расстояние между элементами на печатной плате 

А. 0,2 мм В. 0,1 мм 

Б. 0,3 мм Г. 0,15 мм 

 

13. Минимальное рекомендованное расстояние между элементами и краем печатной 

платы 

А. 2 мм В. 1 мм 

Б. 0,7 мм Г. 1,5 мм 

 

14. Какая группа команд включает команды формирования различного вида отчетов, а 

также команды измерения расстояний между объектами 

А. Place В. Tools 

Б. Reports Г. Bus 
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2.2 Задания для самостоятельной работы  

Создание презентационных материалов и технической документации к курсовому проекту 

производится на основании основной и дополнительной литературы, рекомендуемой к 

выполнению самостоятельной работы. Работа является индивидуальной с использованием 

программы PowerPoint. Выполненная работа должна соответствовать стандарту СГУ. 

Задание 1. Создать презентацию курсового проекта. 

Порядок выполнения задания 

На основании основной и дополнительной литературы, рекомендуемой к выполнению 

самостоятельной работы необходимо подготовить презентационную работу, в которой 

описать порядок выполнения плана работы по курсовому проекту, этапы проектирования 

электронного устройства с использованием программы Altium Designer. Презентация 

должна включать итоговый вариант проекта. 

Задание 2. Составить техническую документацию для проектируемого электронного 

устройства с использованием программы Altium Designer 

Порядок выполнения задания 

На основании основной и дополнительной литературы, рекомендуемой к выполнению 

самостоятельной работы необходимо изучить материалы (технические характеристики, 

техническое описание и т.п.) прототипов, провести патентный поиск. Необходимо 

раскрыть сущность, определить достоинства и недостатки. Студенты должны владеть 

информацией и быть готовы отвечать на контрольные вопросы. 

 

Требования к структурным элементам презентации 

Титульный лист является первым слайдом презентации, служит источником информации, 

необходимой для обработки и поиска документа. 

На титульном слайде приводят следующие сведения: 

 наименование СПО; 

 наименование и шифр дисциплины; 

 тема проекта; 

 фамилия и инициалы студентов (при групповой работе) 

 фамилия и инициалы руководителя проекта. 

Содержание включает введение, наименование всех глав, разделов, подразделов, пунктов 

(если они имеют наименование) и заключение. 

Введение должно содержать оценку современного состояния решаемой проблемы 

проекта. Во введении должны быть показаны актуальность темы, цели и задачи, которые 

актуализируются при выполнении проекта, а также методы и функционал платформы 

разработки, которыми воспользовался студент. 

Основную часть презентации следует делить на главы или разделы. Разделы основной 

части могут делиться на пункты и подразделы. Пункты, при необходимости, могут 

делиться на подпункты. Каждый пункт должен содержать законченную информацию. 

Заключительный слайд должен содержать выводы по результатам выполненной работы, а 

также демонстрировать итоговый вариант проекта. 
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2.3 Промежуточная аттестация 

Промежуточная аттестация по дисциплине проводится в форме защиты курсового проекта 

с использованием следующих цифровых платформ: Google Meet, Ipsilon, Zoom, Discord. 

Проект разрабатывается обучающимся в соответствии с выбранной темой и представляет 

собой проектирование схемы электронного устройства на основе печатного монтажа с 

использованием программы Altium Designer.  

Примерные темы курсового проекта: 

Разработать топологию печатной платы принципиальной для принципиальной схемы: 

1. Усилителя мощности 

2. Функционального генератора 

3. Генератора НЧ 

4. Таймера включения света 

5. Электронного термометра 

Целью курсового проекта является закрепление и расширение знаний, полученных на 

лекциях и практических занятиях по основам проектирования электронных приборов и 

устройств на основе печатного монтажа, на конкретном примере проектирования 

устройства, выполняющего заданные функции. Проектирование нового устройства, как 

правило, проводится на базе прототипа. Работа над курсовым проектом ведется обычно 

индивидуально.  

Проект должен содержать следующее: 

 расширенное техническое задание; 

 разработанную функциональную схему и расчет параметров входящих в неё блоков; 

 разработанную принципиальную схему, расчет параметров компонентов и выбор их 

типов; 

 расчет надежности разработанного устройства; 

 разработанную печатную плату. 

Обучающийся демонстрирует презентацию, схемы и чертежи печатных плат, 

выполненные в соответствии с ЕСКД 
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3 КРИТЕРИИ ОЦЕНКИ 

 

3.1 Критерии оценивания устного опроса 

Оценка «отлично» ставится, если ответ полный и правильный на все вопросы на 

основании ранее изученных знаний; материал изложен в определенной логической 

последовательности технически грамотным языком; 

Оценка «хорошо» ставится, если ответ полный и правильный на все вопросы на 

основании ранее изученных знаний; материал изложен в определенной логической 

последовательности, при этом допущены 2–3 несущественные ошибки; 

Оценка «удовлетворительно» ставится, если ответы на вопросы даны не в полном объеме, 

материал изложен несвязно, при этом допущены существенные ошибки; 

Оценка «неудовлетворительно» ставится, если при ответе обнаружено непонимание 

обучающимся основного содержания учебного материала или отсутствует ответ. 

 

3.2 Критерии оценивания практических работ 

Отчет по практической работе должен содержать: 

 название работы; 

 цель и содержание работы; 

 краткое описание всех операций, необходимых для выполнения задания и 

сравнительный анализ с ранее изученным материалом по технологии выполнения 

операций; 

 ответы на контрольные вопросы. 

Оценка «отлично» ставится, если работа выполнена в полном объеме с соблюдением 

необходимой последовательности. Обучающиеся работают полностью самостоятельно: 

подбирают необходимые для выполнения предлагаемых работ источники знаний, 

показывают необходимые для проведения работы теоретические знания, практические 

умения и навыки. Работа оформляется аккуратно, в наиболее оптимальной для фиксации 

результатов форме. 

Оценка «хорошо» ставится, если работа выполнена учащимся в полном объеме и 

самостоятельно. Допускаются отклонения от необходимой последовательности 

выполнения, не влияющие на правильность конечного результата. Учащийся использует, 

указанные учителем источники знаний. Работа показывает знание учащимся основного 

теоретического материала и овладение умениями, необходимыми для самостоятельного 

выполнения работы. Могут быть неточности и небрежность в оформлении результатов 

работы. 

Оценка «удовлетворительно» ставится, если работа выполняется и оформляется учащимся 

при помощи преподавателя. На выполнение работы затрачивается много времени. 

Учащийся показывает знания теоретического материала, но испытывает затруднение при 

самостоятельной работе с источниками знаний или приборами. 

Оценка «неудовлетворительно» ставится, если результаты, полученные обучающимися, 

не позволяют сделать правильных выводов и полностью расходятся с поставленной 

целью. Показывается плохое знание теоретического материала и отсутствие необходимых 

умений.  
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3.3 Критерии оценивания тестовых работ 

При оценивании тестовых работ оценка «отлично» ставится при прохождении теста при 

условии правильного выполнения 90 – 100% заданий, оценка «хорошо» ставится при 

условии правильного выполнения 78 – 89% заданий, оценка «удовлетворительно» при 

условии правильного выполнения 60 – 77% заданий, оценка «неудовлетворительно» при 

условии правильного выполнения менее 59% заданий. 

 

3.4 Критерии оценивания защиты проекта 

Развернутый ответ студента должен представлять собой связное, логически 

последовательное сообщение на заданную тему, показывать его умение применять 

определения, правила в конкретных случаях. 

Критерии оценивания: 

1) полнота и правильность ответа; 

2) степень осознанности, понимания изученного; 

3) языковое оформление ответа. 

Оценка «отлично» ставится, если: 

1) студент полно излагает материал, дает правильное определение основных понятий; 

2) обнаруживает понимание материала, может обосновать свои суждения, применить 

знания на практике, привести необходимые примеры не только из учебника, но и 

самостоятельно составленные; 

3) излагает материал последовательно и правильно с точки зрения норм 

литературного языка. 

Оценка «хорошо» – студент дает ответ, удовлетворяющий тем же требованиям, что и для 

отметки «5», но допускает 1–2 ошибки, которые сам же исправляет, и 1–2 недочета в 

последовательности и языковом оформлении излагаемого. 

Оценка «удовлетворительно» – студент обнаруживает знание и понимание основных 

положений данной темы, но: 

1) излагает материал неполно и допускает неточности в определении понятий или 

формулировке правил; 

2) не умеет достаточно глубоко и доказательно обосновать свои суждения и привести 

свои примеры; 

3) излагает материал непоследовательно и допускает ошибки в языковом оформлении 

излагаемого. 

Оценка «неудовлетворительно» ставится, если студент обнаруживает незнание большей 

части соответствующего вопроса, допускает ошибки в формулировке определений и 

правил, искажающие их смысл, беспорядочно и неуверенно излагает материал. 
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